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Claris FileMaker Pro 21.1.1 Release Notes 
November 2024 

This software updates FileMaker Pro 2024 to version 2024 (21.1.1) and addresses issues. If you are unable 
to successfully update to FileMaker Pro 2024 (21.1.1), search the Knowledge Base for installation 
information. 

New features and enhancements 

Artificial intelligence 

• Performing semantic finds for images using open source models 

• The Insert Embedding and Insert Embedding in Found Set script steps as well as 
the GetEmbedding function can now send images to a model that supports image 
embedding. When you use the returned image embedding data with the Perform 
Semantic Find script step, you can now specify text or embedding data for an image to 
query a set of records for those with similar images. 

• To get embedding vectors for both text and image data using models that run on your 
own hardware, you can now use the open source model server provided separately 
with FileMaker Pro or installed with FileMaker Server. 

For more information about the open source model server and performing semantic finds for images, 
see the Claris Engineering Blog. 

• Cohere is now supported as a model provider that you can specify in the Configure AI 
Account script step. See Claris FileMaker 2024 Technical Specifications for the supported 
embedding models. 

• To verify the SSL certificate of an open source model provider's server before sending data, 
you can now enable the Verify SSL Certificates option in the Configure AI Account script step. 

• The new Save result option lets you save the found set returned by the Perform Semantic 
Find script step as a JSON array. 

• With the new Truncate Messages option, the Set AI Call Logging script step lets you shorten 
some of the longer log messages. 

• The Get(LastStepTokensUsed) now also returns the number of records that received 
embedding vectors or were skipped after an Insert Embedding in Found Set script step. 

Open Quickly 

• Custom app developers can now control whether users can access any layouts and scripts 
from the Open Quickly box. The new Allow Open Quickly access to layouts and 
scripts privilege is deselected by default in all accounts without full access. For more on how 
this and other privileges and settings affect Open Quickly results, see Controlling Open Quickly 
access. 

• For accounts with full access privileges, Open Quickly results can now include tables, fields, 
and table occurrences. Clicking a result opens the Manage Databases dialog with the result 

https://help.claris.com/en/pro-help/content/insert-embedding.html
https://help.claris.com/en/pro-help/content/insert-embedding-in-found-set.html
https://help.claris.com/en/pro-help/content/getembedding.html
https://help.claris.com/en/pro-help/content/perform-semantic-find.html
https://help.claris.com/en/pro-help/content/perform-semantic-find.html
https://support.claris.com/s/article/Claris-Engineering-Blog
https://help.claris.com/en/pro-help/content/configure-ai-account.html
https://help.claris.com/en/pro-help/content/configure-ai-account.html
https://www.filemaker.com/redirects/fmm21_admin.html?page=tech_specs&lang=en
https://help.claris.com/en/pro-help/content/configure-ai-account.html
https://help.claris.com/en/pro-help/content/perform-semantic-find.html
https://help.claris.com/en/pro-help/content/perform-semantic-find.html
https://help.claris.com/en/pro-help/content/set-ai-call-logging.html
https://help.claris.com/en/pro-help/content/get-laststeptokensused.html
https://help.claris.com/en/pro-help/content/controlling-open-quickly-access.html
https://help.claris.com/en/pro-help/content/controlling-open-quickly-access.html
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selected. And while in the Manage Databases dialog, you can use the Open Quickly box to 
search for only the items in Manage Databases. 

• The Open Quickly box now by default limits the search for items that are within a file (for 
example, layouts and scripts) to only those in the current file. To extend the search to all open 
files, you can deselect the current file option. 

• To help you distinguish between types of items, category headings now separate Open Quickly 
results for files, layouts, scripts, tables, fields, and table occurrences into their own groups.  

See Using the Open Quickly box. 

macOS Sequoia support 

• This release adds support for macOS Sequoia 15. 

Note  FileMaker Pro 2024 is not supported on macOS Monterey 12 and, in this release, will no longer 
install on Monterey. If you're a Monterey user, you must upgrade to a later version of macOS before 
you can install this version of FileMaker Pro. For the supported versions of macOS, see Claris 
FileMaker 2024 Technical Specifications. 

Script steps 

New script steps: 

• The Set Revert Transaction on Error script step lets you control whether transactions are 
immediately reverted when an error occurs, which is the default behavior. When your script 
needs to do its own error handling, set this script step to Off. 

Script step enhancements: 

• To streamline creating scripts, many script step options now default to more commonly used 
values, so you likely won't need to change them every time you use them. For example: 

• The Go to Record/Request/Page and the Go to Portal Row script steps when set 
to Next or Previous now default the Exit after last option to On rather than Off. 

• The With dialog option in most cases now defaults to Off rather than On. 

• The Create folders option used in Export Records, Export Field Contents, and other 
script steps now defaults to On rather than Off. 

• To let you control whether auto-enter options are performed at all within a transaction 
(whether by importing or otherwise creating or modifying records), the Open 
Transaction script step provides the new option Skip auto-enter options. When this option 
is Off (the default), auto-enter options are performed in fields for all new or modified records 
when the Commit Transaction script step is reached. When this option is On, auto-enter 
options are not performed for any fields. 

• To improve the performance of some find requests that use the Constrain Found Set script 
step and use criteria fields that are indexed, you can use the new Find without indexes option. 
This option may be particularly helpful for constrained finds that operate on found sets that 
are already a small subset of the total number of records in the table. 

https://help.claris.com/en/pro-help/content/using-open-quickly-box.html
https://www.filemaker.com/redirects/fmm21_admin.html?page=tech_specs&lang=en
https://www.filemaker.com/redirects/fmm21_admin.html?page=tech_specs&lang=en
https://help.claris.com/en/pro-help/content/set-revert-transaction-on-error.html
https://help.claris.com/en/pro-help/content/open-transaction.html
https://help.claris.com/en/pro-help/content/open-transaction.html
https://help.claris.com/en/pro-help/content/constrain-found-set.html
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• When writing data, the Execute FileMaker Data API script step now supports overriding 
the Prohibit modification of value during data entry option for auto-enter data in a field. In 
the request, set the new prohibitMode key in the options object to script (ignore this auto-
enter rule) or user (follow this auto-enter rule). 

• In the Save a Copy as XML script step, you can now select the Include details for analysis 
tools option. This option adds a DDR_INFO element to the XML file, which provides additional 
information that's useful to third-party tools you can use to analyze your custom app. 

Functions 

New functions: 

• The new Get(RevertTransactionOnErrorState) function lets you detect whether the Set Revert 
Transaction on Error script step is currently on. 

• The new ExecuteSQLe function is identical to the existing ExecuteSQL function, except that, if 
an SQL error occurs, it returns ? followed by a detailed error message. 

• The new Get(SystemStorageAvailable) function returns the available storage, in bytes, on the 
system drive where the FileMaker software is installed. 

Function enhancements: 

• With support for Live Text in the Arabic language added in iOS 18, iPadOS 18, and macOS 
Sequoia 15, the GetLiveText and GetLiveTextAsJSON functions now support language codes 
"ar-SA" and "ars-SA" as well. 

Layouts 

• Changing a field name or table occurrence name in the Manage Database dialog now 
automatically updates fully-qualified field names (table::field) in layout calculations. Also, 
layout calculations now support the use of function names and keywords in supported 
languages across all clients and hosts. 

• You can now change the default theme that's used when creating new layouts. See Managing 
layout themes. 

Database schema 

• In the Options for Field dialog, the Display custom message if validation fails option now lets 
you specify a calculation, enabling you to internationalize the message or otherwise make the 
message dependent on the context. See Defining field validation. 

• For externally stored container fields that use secure storage, you can now opt to store files in 
fewer folders so that moving a database with its external container data is faster. In the 
Options for Field dialog, choose the With fewer folders option for the selected container field 
with secure storage. Note: This option is not compatible with earlier versions of FileMaker 
clients and hosts. See Setting up container fields to store data externally. 

Security 

• In a file that authorizes specific external files to access it, you can now further require that the 
external files must be on the same host as the current file by selecting the All files must be on 
the same host option. See Authorizing access to files. 

https://help.claris.com/en/pro-help/content/execute-filemaker-data-api.html
https://help.claris.com/en/pro-help/content/save-a-copy-as-xml.html
https://help.claris.com/en/pro-help/content/get-reverttransactiononerrorstate.html
https://help.claris.com/en/pro-help/content/executesqle.html
https://help.claris.com/en/pro-help/content/get-systemstorageavailable.html
https://help.claris.com/en/pro-help/content/getlivetext.html
https://help.claris.com/en/pro-help/content/getlivetextasjson.html
https://help.claris.com/en/pro-help/content/managing-themes.html
https://help.claris.com/en/pro-help/content/managing-themes.html
https://help.claris.com/en/pro-help/content/field-validation.html
https://help.claris.com/en/pro-help/content/store-data-externally.html
https://help.claris.com/en/pro-help/content/authorizing-access.html
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Application 

• In the following dialogs, changes you make to column widths are now saved and used when 
you reopen the dialogs: 

Conditional Formatting, Manage Custom Functions, Manage Custom Menus, Manage Database, 
Manage External Data Sources, Manage Layouts, Manage Security, and Manage Value Lists 

• When importing a folder of text files all at once, you can now import files with the .xsl and 
.xslt filename extensions. 

• When a table occurrence is deleted from a file, the Manage Layouts dialog now shows 
<unknown> in the Associated Table column for layouts based on the deleted table occurrence. 
Previously, the table occurrence name was blank. 

• When you click Tools > Save a Copy as XML, you can now select the Include details for analysis 
tools option. This option adds a DDR_INFO element to the XML file, which provides additional 
information that's useful to third-party tools you can use to analyze your custom app. 

• To make it easier to change the file cache size at install time for large deployments, you can 
now set the AI_SET_FILE_CACHE property in the Assisted Install.txt file. See Setting 
personalization properties in Assisted Install.txt. 

• The name of the Preferences dialog is now Settings. 

Save a Copy as XML 

When a FileMaker Pro file is saved using Save a Copy as XML: 

• With the Include details for analysis tools option selected: 

• The text of each script step in each script is now included in the DDR_INFO element in 
the XML file for the benefit of database analysis tools. 

• Details for calculation chunks are now represented in the DDR_INFO element in the 
XML file. For each calculation, there's now an element along with its calculation 
chunks so that database analysis tools can track references to fields, functions, and 
custom functions. 

• Details for the external data source of an additional field used to sort a summary field 
are now represented in the DDR_INFO element in the XML file. For each such 
FieldReference element, there's now a FieldReference element under DDR_INFO that 
includes information about the external data source. 

• Accounts that have an empty password are now reflected in the XML file by having no 
INSECURE_PASSWORD element. 

Updated libraries and packages 

• OpenSSL has been upgraded to version 3.3.1. 

  

https://help.claris.com/en/pro-network-install-setup-guide/content/setting-personalization-properties.html
https://help.claris.com/en/pro-network-install-setup-guide/content/setting-personalization-properties.html
https://help.claris.com/en/pro-help/content/save-a-copy-as-xml.html
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Tools 

• FileMaker plug-ins installed on FileMaker Server can now receive notifications when schema 
changes are made in a hosted file. For more information, see the README.txt file in 
the FileMaker plug-in SDK. 

• The FileMaker upgrade tool now supports changing any of the on/off options found in the File 
Options dialog. Options that require a text value (such as minimum version) or require more 
complex selections (such as script triggers) aren't supported. For more information, 

see FileMaker Upgrade Tool Guide. 

Addressed issues 

Script steps 

• Windows: If no supported email client application was found, the Send Mail script step 
returned error code -1 ("Unknown error"). Now, it returns error code 119 ("No supported 
email client found"). 

• When the default email client application was not set to Outlook (Windows) or Mail.app 
(macOS), the Send Mail script step, when set to send via an email client, displayed an 
inaccurate error message. Now, the error message says that no supported client was found. 

• When the Insert from URL script step was performed with the --location cURL option, an error 
was returned that the hostname for the SSL certificate didn't match that of the specified URL 
when the host redirected to a URL with a different hostname. 

Functions and calculations 

• When a positive number was subtracted from a date or timestamp value, and the expected 
result was a negative number, the returned value was a negative number as expected. 
However, when a negative number was added to a date or timestamp value, and the expected 
result was a negative number, the returned value was "?". Now, instead of "?", the expected 
negative value is returned. 

• The Base64EncodeRFC function returned the value of the RFCNumber parameter when the 
value of the data parameter was an empty string. Now, it returns an empty string. 

• When evaluated by certain JSON functions, JSON key names that included a Unicode null 
character (\u0000) caused FileMaker clients and hosts to become unresponsive or quit 
unexpectedly. 

Application 

• macOS: When you created a new file and specified a filename in the Save As field to save the 
file on your Mac, the keyboard shortcuts to copy, cut, paste, select all, undo, and redo didn't 
work. 

• macOS: In Layout mode, when you pressed the Shift key to limit the direction of an object's 
movement while dragging it horizontally, in some situations the object moved only vertically, 
not horizontally as expected. 

https://www.filemaker.com/redirects/fmp21_admin.html?page=help_pluginsdk&lang=en
https://help.claris.com/en/app-upgrade-tool-guide/content/index.html
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• Windows: When entering Japanese text in a dialog's text boxes for certain script steps in the 
Script Workspace, selecting conversion candidates in the input method editor (IME) using the 
Tab key didn't insert the selection into the text box and deleted existing text in the text box. 

• Windows: In Layout mode, after you chose Insert > Other Symbol, the longest symbol names 
in the dialog were truncated. 

• When FileMaker Pro connected to a file on a host whose SSL certificate couldn't be verified 
(the file's security lock icon was orange), interactive container fields in the hosted file didn't 
display their contents as expected. 

• Mac with Apple silicon: With an object selected in Layout mode and the Inspector open, when 
you dragged a shade of gray from the top row of the color palette to the theme color area, 
then clicked the dark variation (black) of this custom color to apply it to the selected object, 
the object color changed to purple rather than the selected color. 

• In the Edit Find Request dialog, when the selected field was a time, date, or timestamp field, 
full-width characters entered for Criteria were changed to half-width characters after clicking 

Add or Change. For example, a variable named "$aーb：c／d" was changed to "$a-b:c/d" (a 

different variable name), which caused the find request to fail. 

• In certain situations, after you clicked the next or previous record button in the status toolbar 
then dragged the slider to another record, FileMaker Pro quit unexpectedly. 

• For portals with a top border and portal rows with a bottom border, each time you dragged a 
handle to resize only the width of the portal in Layout mode, the height of the portal rows 
increased by a small amount. 

• For a text or number field with its control style set to Pop-up Menu and using a value list, in 
Table View, after you created enough records to fill the height of the window then clicked the 
gray area below the last record, FileMaker Pro quit unexpectedly. 

Layouts 

• macOS: In a web viewer where the webpage contains a file input field with the "multiple" 
attribute set, clicking the Choose Files button in the web viewer and selecting files didn't allow 
you to select multiple files. 

Security 

• Using an account with a privilege set that allowed only creating and viewing records, in limited 
circumstances a user was also able to edit the records they created in a previous session if the 
file was hosted but not if the file was opened locally. If the hosted file was opened by different 
accounts with the same privilege set and from the same client computer as that of the 
account that created these records, then those accounts were also able to edit these records. 

Save a Copy as XML 

When a FileMaker Pro file was saved using Save a Copy as XML: 

• The state of the Don't display in host's file list options for FileMaker clients and 
FileMaker WebDirect were missing in the XML file. Now, they're reflected in the 
HideClientSharing and HideWebDirectSharing elements. 
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• The predefined privilege sets were missing access details in the PrivilegeSet element in the 
XML file. 

• The XML grammar used in privilege set access for record, layout, value list, and script 
privileges was inconsistent, and default privilege sets were missing access details in the 
XML file. 

• Export Records script steps were missing the DataSourceReference element for fields in 
external data sources that were specified in the export field order. 

Tools 

• In the FileMaker plug-in API, FMX_SetToCurrentEnv returned the 100 error when no files were 
open to indicate there was no file to set it to, but the environment didn't work for non-file 
related operations. Now, it still returns 100 in this case, but it does allow non-file operations 
to work much like they do in the FileMaker Pro Data Viewer when no files are open. 

 

Known issues 

For layout calculations: 

• Created in a previous version of FileMaker Pro: 
• The result displayed in Browse mode is "?" if the layout calculation includes a field 

reference without a table reference. 
• In Layout mode, right-clicking the text frame containing the layout calculation then 

choosing Edit Layout Calculation doesn't open the Specify Calculation dialog as expected. 
• With a malformed calculation format: 

• In Layout mode, right-clicking the text frame containing the layout calculation then 
choosing Edit Layout Calculation doesn't open the Specify Calculation dialog as expected. 

Workaround: In Layout mode, double-click the layout calculation's text frame first, so that the insertion 
point is inside the text frame. Then right-click inside the text frame and choose Edit Layout Calculation. 
After you close the Specify Calculation dialog, save the layout. After that, the layout calculation displays as 
expected in Browse mode, and you no longer need to double-click the text frame first in Layout mode. 

Platform Product Updates Version Download Languages 

Windows 
FileMaker Pro 
2024 

21.1.1 

FileMaker Pro 21.1.1 Updater (setup.exe) 

 
English 
Czech 
Polish 
Turkish 
Russian  macOS 

FileMaker Pro 
2024 

21.1.1 

FileMaker Pro 21.1.1 Updater 

 

 
APIs, technologies, or features to be deprecated 
As FileMaker Pro evolves, the list of supported technologies, APIs, and features will change. As part of this 
evolution, certain operating systems versions, hardware, and features may be deprecated in favor of 
newer ones. Although deprecation does not mean the immediate deletion of an item, you should migrate 

https://download.winsoft-international.com/7d600de4c494c16e89b6d5eef5bg2c86/Store/FileMaker21/FileMakerPro-Adv/CE/fmp_21.1.1.12_ce_x64.exe
https://download.winsoft-international.com/7d600de4c494c16e89b6d5eef5bg2c86/Store/FileMaker21/FileMakerPro-Adv/CE/fmp_21.1.1.12_ce.dmg
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your solution away from deprecated technologies, because these technologies may be removed in a 
future version of the product. 

For the latest information about deprecated APIs, technologies, and features, search the Knowledge Base. 
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	Functions and calculations
	• When a positive number was subtracted from a date or timestamp value, and the expected result was a negative number, the returned value was a negative number as expected. However, when a negative number was added to a date or timestamp value, and th...
	• The Base64EncodeRFC function returned the value of the RFCNumber parameter when the value of the data parameter was an empty string. Now, it returns an empty string.
	• When evaluated by certain JSON functions, JSON key names that included a Unicode null character (\u0000) caused FileMaker clients and hosts to become unresponsive or quit unexpectedly.
	Application
	• macOS: When you created a new file and specified a filename in the Save As field to save the file on your Mac, the keyboard shortcuts to copy, cut, paste, select all, undo, and redo didn't work.
	• macOS: In Layout mode, when you pressed the Shift key to limit the direction of an object's movement while dragging it horizontally, in some situations the object moved only vertically, not horizontally as expected.
	• Windows: When entering Japanese text in a dialog's text boxes for certain script steps in the Script Workspace, selecting conversion candidates in the input method editor (IME) using the Tab key didn't insert the selection into the text box and dele...
	• Windows: In Layout mode, after you chose Insert > Other Symbol, the longest symbol names in the dialog were truncated.
	• When FileMaker Pro connected to a file on a host whose SSL certificate couldn't be verified (the file's security lock icon was orange), interactive container fields in the hosted file didn't display their contents as expected.
	• Mac with Apple silicon: With an object selected in Layout mode and the Inspector open, when you dragged a shade of gray from the top row of the color palette to the theme color area, then clicked the dark variation (black) of this custom color to ap...
	• In the Edit Find Request dialog, when the selected field was a time, date, or timestamp field, full-width characters entered for Criteria were changed to half-width characters after clicking Add or Change. For example, a variable named "$aーb：c／d" wa...
	• In certain situations, after you clicked the next or previous record button in the status toolbar then dragged the slider to another record, FileMaker Pro quit unexpectedly.
	• For portals with a top border and portal rows with a bottom border, each time you dragged a handle to resize only the width of the portal in Layout mode, the height of the portal rows increased by a small amount.
	• For a text or number field with its control style set to Pop-up Menu and using a value list, in Table View, after you created enough records to fill the height of the window then clicked the gray area below the last record, FileMaker Pro quit unexpe...
	Layouts
	• macOS: In a web viewer where the webpage contains a file input field with the "multiple" attribute set, clicking the Choose Files button in the web viewer and selecting files didn't allow you to select multiple files.
	Security
	• Using an account with a privilege set that allowed only creating and viewing records, in limited circumstances a user was also able to edit the records they created in a previous session if the file was hosted but not if the file was opened locally....
	Save a Copy as XML
	When a FileMaker Pro file was saved using Save a Copy as XML:
	• The state of the Don't display in host's file list options for FileMaker clients and FileMaker WebDirect were missing in the XML file. Now, they're reflected in the HideClientSharing and HideWebDirectSharing elements.
	• The predefined privilege sets were missing access details in the PrivilegeSet element in the XML file.
	• The XML grammar used in privilege set access for record, layout, value list, and script privileges was inconsistent, and default privilege sets were missing access details in the XML file.
	• Export Records script steps were missing the DataSourceReference element for fields in external data sources that were specified in the export field order.
	Tools
	• In the FileMaker plug-in API, FMX_SetToCurrentEnv returned the 100 error when no files were open to indicate there was no file to set it to, but the environment didn't work for non-file related operations. Now, it still returns 100 in this case, but...
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